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Overview

This chapter covers the following topics:

¢ Performance Insight and the Ethernet Statistics Group
e RMON Ethernet Statistics

e Enhancements to version 3.1

¢ Integration with Network Node Manager (NNM)

e  Option for customizing reports

e Sources for additional information

Performance Insight and the Ethernet Statistics Group

Performance Insight collects data from many sources, performs in-depth trend analysis,
maintains performance baselines, and provides users with convenient, web-based reporting.
Following is a partial list of product features:

e Distributed architecture

e Easy to scale (supports data collection from thousands of agents)
e CODA/OVPA agent support

e Multi-company security model

e Data warehousing

e Near Real Time reporting

e Forecasting

e Extensive aggregation (by day, week, month; by location, by customer)
¢ Thresholding and alerting

e FKasy identification of bottlenecks

e [Easy assessment of capacity trends

e Accurate and timely documentation for management

RFC2821 defines the statistics and functions that an RMON probe exchanges with a console
manager. The Ethernet Statistics Group is one of several data groups defined by RFC2821.
Data in the Ethernet Statistics Group is produced by the following counters:

¢ Drop events
e Octets
e Packets



¢ Broadcast packets

e  Multicast packets

e CRC alignment errors

¢ Undersized packets

e Oversized packets

e Fragments

e Jabbers

¢ Collisions

e Packets containing fewer than 64 octets

e Packets containing between 65 and 127 octets

e Packets containing between 128 and 255 octets
e Packets containing between 256 and 511 octets
e Packets containing between 512 and 1023 octets
e Packets containing between 1024 and 1518 octets

RMON Ethernet Statistics

The reports in RMON Ethernet Statistics will tell you what the counters listed above are
picking up. RMON Ethernet Statistics contains the following reports:

1 Historical Broadcast/Multicast Packet Analysis

Near Real Time Broadcast/Multicast Packet Analysis
Historical Packet Size Distribution

Near Real Time Packet Size Distribution

Historical Error

Near Real Time Error

N 00 o A WN

Drop Events
8 Inventory Report

Historical reports compare yesterday’s performance to performance over the previous month.
Near Real Time reports look at performance over the previous 12 hours. The counts and
percentages you see in a Near Real Time report factor in data retrieved by the most recent
poll, which took place within the last few minutes.

Enhancement to Version 3.1

New Features

¢ Location Independent Reporting (LIR)
e SQL modified for object delete
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Upgrade Package
e UPGRADE_RMON_EthernetStatistics_to_31.ap

New Release of the Datapipe
e RMON_EthernetStatistics Datapipe 3.2

For details about previous enhancements, and defect fixes, see Appendix A, Version History.

Integration with Network Node Manager (NNM)

If you use NNM as well as PI, you have the option of improving your ability to diagnose
problems by integrating PI with NNM. In the past, you integrated NNM and PI by installing
packages on both servers. This procedure recently changed. Package installation is no longer
necessary, as both NNM and PI ship with the necessary packages already installed. Instead of
installing packages, you run an integration script on the NNM server and you launch the
Integration Wizard on PI.

If NNM and PI are integrated, or if you are about to integrate them, be sure to install the
thresholds sub-package that comes with RMON Ethernet Statistics. Installing the thresholds
sub-package configures the Thresholds Module to monitor the PI database for broadcast/
multicast threshold breaches and respond to a breach by taking an action. The default action
is to send a breach trap to NNM. The breach trap received by NNM becomes an alarm in the
NNM alarm browser, which the NNM operator can respond to by launching an PI report.

Configuring the Thresholds Module is not necessary. You do not need to define an action or
specify a destination for breach traps. However, you are free to modify category, severity, and
destination parameters at any time. For details about these options, refer to the Thresholds
Module User Guide.

Options for Customizing Reports

You can customize the reports in this package by applying group filters, by editing parameters,
tables, and graphs, and by importing custom property data such as customers and locations.
Service providers, or any organization that wants to share reports with customers, use group
filters to produce customer-specific reports. Edits to parameters, tables, and graphs are
temporary changes and anyone can make these changes.

Group Filters

Overview

If you intend to share reports with customers, you will need customer-specific reports.
Creating customer-specific reports involves the following steps:

e Importing custom property information (customer names and device locations) using
Common Property Tables

¢ Creating a group account for all of the users affiliated with a particular customer
e Creating a group filter for the group account
For more information about group filters, refer to the PI Administration Guide.



Editing Parameters

When you edit a parameter, you apply a constraint. The constraint eliminates data you do not
want in the report. For example, if you edit the Customer Name parameter, data for every
customer except the customer you typed in the Customer Name field will disappear.

You can apply multiple constraints at once. RMON Ethernet Statistics supports the following
parameters:

¢ Customer Name

e Device

¢ Interface

e Protocol

e Location

If you are viewing the report remotely (using the Web Access Server), apply a constraint by

clicking the Edit Parameters icon at the bottom right-hand corner of the report. When the
Edit Parameters window opens, enter the constraint in the field and click Submit.

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the
Modify Parameter Values window opens, click Current Value. Type a new value and click OK.

Tables and Graphs

In addition to applying constraints, you can modify individual tables and graphs within a
report. To do this, click the Edit Table and Edit Graph icons, or simply right-click the object if
you are using the Report Viewer application. For details about view options for tables and
graphs, see Appendix A, Editing Tables and Graphs.

Custom Property Information

All the property information that pertains to an interface (interface speed, customer, location,
device name, and UtilThreshold) is inherited from the Interface Reporting Report Pack. If you
want to change the utilization threshold, you can let PI read a property import file that you
create yourself or you can work with the Change Protocol Defaults form that comes with
Interface Reporting. For details, see Chapter 3, Changing Thresholds.

Sources for Additional Information

The demo package that comes with RMON Ethernet Statistics contains a sample of each
report in the package. If you have access to the demo package and you want to know what
fully-populated reports look like, install the demo package. Demo reports are interactive;
selection tables are linked to graphs, and you can experiment with parameters and view
options.

For information about recent enhancements to this package and any known issues, refer to:
e  RMON Ethernet Statistics Report Pack Release Notes

The following documents are related to this manual:

e Interface Reporting Report Pack User Guide

e Common Property Tables User Guide
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Overview

e PI Report Packs, CD-ROM Release Notes, October 2007

Manuals for the core product, OVPI, and manuals for the reporting solutions that run on
OVPI, are posted to the following web site:

http://ovweb.external.hp.com/lpe/doc_serv/

The user guides for OVPI are listed under Performance Insight. The user guides for report
packs and datapipes are listed under Performance Insight Report Packs. Every user guide
indicates a date. If a manual is revised and reposted, the date will change. Since we post
revised manuals on a regular basis, you should compare the date on your PDF to the date of
the PDF on this web site. If the web edition is newer, download the web edition.

i
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2 Package Installation

This chapter covers the following topics:
¢ Guidelines for a Smooth Install

e Upgrading to Version 3.1

e Installing RMON Ethernet Statistics
e Accessing Deployed Reports

e Package Removal

Guidelines for a Smooth Install

An OVPI reporting solution has two ingredients, a report pack and a datapipe. Some reporting
solutions include multiple datapipes. When you install a datapipe, you configure OVPI to
collect a specific type of performance data at a specific interval. When you install a report
pack, you configure OVPI to summarize and aggregate the data collected by the datapipe.

If you install the RMON Ethernet Statistics Datapipe, you will configure OVPI to poll the
RMON MIB. Installing the RMON Ethernet Statistics Report Pack configures OVPI to
process data collected by the datapipe, generate trending analysis, and display the results of
that analysis in a series of reports.

The report pack CD-ROM contains report packs, datapipes, and several shared packages.
When you insert the CD in the CD-ROM drive and launch the package extraction program,
the install script on the CD extracts every package to the Packages directory on your system.
When the extract finishes, the install script prompts you to launch OVPI and start Package
Manager. Before using Package Manager, review the following guidelines.

Software Prerequisites
RMON Ethernet Statistics Reporting has a combination of core-product requirements and
package-level requirements. The core product requirements are as follows:
¢ Performance Insight 5.3
e All available Service Packs for PI1 5.3

You will find information about each service pack, including installation instructions, in the
release notes for the service pack. The package-level prerequisites are as follows:

e Common Property Tables 3.7

e Interface Reporting 5.3

¢ Interface Discovery Datapipe 2.5

e Interface Reporting ifEntry Datapipe 2.5

3



Common Property Tables

If you are running an earlier version of Common Property Tables (version 3.5 or earlier),
upgrade to version 3.6. Installing the upgrade package for Common Property Tables is no
different from installing any other upgrade package; however, you cannot install other
packages when you install this upgrade package. Install the upgrade package for Common
Property Tables and only the upgrade package for Common Property Tables.

Running this Package in a Distributed Environment

If you intend to run RMON Ethernet Statistics as a distributed system across multiple
servers, the central server, every satellite server, and every remote poller must be running the
same version of PI and the same service packs. When you finish installing packages, you must
configure the central and satellite servers. For details, see Chapter 4, Setting Up a
Distributed System.

Upgrading to Version 3.1

If you are currently running an earlier version of RMON Ethernet Statistics, you can upgrade
to version 3.1 by installing the “to_31” upgrade package. Follow this sequence:

1 Uninstall the existing datapipe: RMON EthernetStatistics Datapipe 3.1
2 Install UPGRADE_RMON_EthernetStatistics_to_31 (by itself, no other packages)
3 Install the new datapipe: RMON EthernetStatistics Datapipe 3.2

Before doing the upgrade, you may need to save configuration data related to polling policies
and polling groups. In addition, you may need to delete any views of data or property tables
that you created yourself. If you do not delete custom table views, the report pack upgrade
process may fail.

Datapipes and Remote Pollers

When you uninstall an existing datapipe, the following information will be lost:
¢ The polling policy for a single remote poller

e (Cloned polling policies for multiple remote pollers

e (Customized polling groups

You can export existing polling policy configurations and customized polling groups by using
the collection_manager and group_manager commands.

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager
command to export existing policy configurations to a file.

UNIX: As user trendadm, run the following command:
cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst
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Windows: As Administrator, launch a command window. Navigate to the OVPI install
directory and execute the following command:

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations
If your environment contains customized polling groups, use the group_manager command to
export groups to individual .xml files.
UNIX: As user trendadm, execute the following command:
cd $DPIPE_HOME
./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install
directory and execute the following command:

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created custom views for data or property tables, the views you created may interfere
with the report pack upgrade, causing it to fail. Whether or not your custom views interfere
with the upgrade process depends on how you created them. If you created them using SQL,
the upgrade will succeed, however, your custom table views will not be available once the
upgrade is complete. If you created them using Datapipe Manager, the upgrade is likely to
fail. To prevent the upgrade from failing, delete custom table views before you upgrade the
report pack, then recreate these views after the upgrade is complete.

Installing RMON Ethernet Statistics

Follow these steps if you are installing RMON Ethernet Statistics for the first time:
e Task 1: Stop OVPI Timer and extract packages from the report pack CD
e Task 2: If necessary, upgrade Common Property Tables
e Task 3: Install the following packages:
— RMON_EthernetStatistics 3.1
— RMON_EthernetStatistics_Thresholds (optional)
— RMON_EthernetStatistics Datapipe 3.2
e Task 4: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD
1 Login to the system. On UNIX systems, log in as root.

2 Stop OVPI timer and wait for processes to terminate.
On Windows, do the following:
a From the Control Panel, select Administrative Tools > Services.

b Select OVPI Timer from the list of services.
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¢ From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop
— Sun: sh /etc/init.d/ovpi_timer stop

Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu opens
automatically. On UNIX, the CD may or may not mount automatically; if it does not
mount automatically, navigate to the top level directory on the CD, and run the ./setup
command.

Type 1 in the choice field and press Enter. The install script displays a percentage complete
bar. When the copy is complete, the install script starts Package Manager. The Package
Manager install wizard opens.

When the copy to the Packages directory is complete, you can navigate to the Packages
directory to see the results. The Packages directory contains separate folders for RMON
Ethernet Statistics and the RMON_EthernetStatistics Datapipe. The following folders appear
under RMON Ethernet Statistics:

RMON_EthernetStatistics.ap
RMON_EthernetStatistics_Demo.ap
RMON_EthernetStatistics_Thresholds.ap
UPGRADE_EthernetStatitiscs_to_31.ap

The following folder appears under RMON_EthernetStatistics Datapipe:

RMON_EthernetStatistics Datapipe.ap

Task 2:Upgrade Common Property Tables

RMON Ethernet Statistics requires Common Property Tables 3.7. If you have not already
upgraded Common Property Tables, install the upgrade package. When you install the
upgrade, do not install other packages at the same time. Install the upgrade for Common
Property Tables and only the upgrade for Common Property Tables. If you need help with the
upgrade, refer to the Common Property Tables User Guide.

Task 3:Install RMON Ethernet Statistics and the datapipe

1

From the Management Console, select Tools > Package Manager. The Package Manager
welcome window opens.

Click Next. The Package Location window opens.

Click Install. Approve the default installation directory; or, if necessary, select a different
directory.

Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the defaults for application server name and port. Type your user name and
password for the OVPI Application Server.

Click Next. The Package Selection window opens.
Click the check box next to the following packages:
RMON_EthernetStatistics
RMON_EthernetStatistics_Thresholds (optional)
RMON_EthernetStatistics_Datapipe
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7  Click Next. The Type Discovery window opens; accept the default.
Click Next. The Selection Summary window opens.

9 Click Install. The Install Progress window opens. When installation finishes, an install
complete message appears.

10 Click Done to return to the Management Console.

Task 4:Restart OVPI Timer

On Windows, do the following:
a From the Control Panel, select Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.

On UNIX, as root, do one of the following:
— HP-UX: sh /sbin/init.d/ovpi_timer start
— Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed this report pack, you enabled the Deploy Reports option. As a result, the
reports in this package (as well as any forms) were deployed to the OVPI Application Server.
Once reports reside on the OVPI Application Server, you have two ways to view them:

e OVPI client applications
e  Web browser

If the client applications are installed on your system, you have access to Report Viewer,
Report Builder, and the Management Console. If the client applications were not installed on
your system, you must use a web browser to view reports.

For details about the client applications, refer to the PI Installation Guide. For details about
the Management Console, including how to use the Object/Property Management view to
launch reports related to a specific object, refer to the PI Administration Guide.

Package Removal

Follow these steps to uninstall RMON Ethernet Statistics.

1 Login to the system. On UNIX systems, log in as root.

2 Stop OVPI timer and wait for processes to terminate.
On Windows, do the following:
a From the Control Panel, select Administrative Tools > Services.
b Select OVPI Timer from the list of services.

¢ From the Action menu, select Stop.

Package Installation 7
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On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

Start Package Manager. The Package Manager welcome window opens.

Click Next. The Package Location window opens.

Click Uninstall.

Click Next. The Package Selection window opens

Click the check box next to the following packages:
RMON _EthernetStatistics
RMON _EthernetStatistics_ Thresholds (if installed)
RMON _EthernetStatistics_Demo (if installed)
RMON_EthernetStatistics_Datapipe

Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens. When removal finishes, a removal complete
message appears.

Click Done.

Restart OVPI Timer.

On Windows, do the following:

a From the Control Panel, select Administrative Tools > Services.
b Select OVPI Timer from the list of services.

¢ From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start
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3 Changing Thresholds

When you installed RMON Ethernet Statistics and deployed reports, you also deployed one
form, the Change Threshold form. This form lets you perform a task related to an object. The
object is either a device and all of its interfaces, or an individual interface.

The Change Threshold form appears under Object Specific Tasks in the Object/Property
Management window. This form (along with other forms) will be listed under Object Specific
Tasks any time you select a device or an interface that is running the RMON probe.

The easy way to change the Broadcast/Multicast Threshold is to use the Change Threshold
form. The more difficult way to modify the threshold is to create a file that includes a new
threshold value, and then let OVPI import your file and update the property table.

Putting Property Data in a File

You can create an import file by building it from scratch, by exporting the required attributes
from your own provisioning database, or by letting OVPI collect some property data on its own
and then exporting what was collected. Since building a property import file from scratch is
not always easy, we recommend that you follow these steps:

1 Allow the system to discover a few devices on its own.
2 Export existing property data from OVPI by typing this command:
trend_proc -f RMON_EtherStats_exportdata.pro
Use the results as a starting point for a property file you will modify.

4 Store your modified file in the correct directory (where OVPI expects to find it) and import
the file by typing this command:

trend_proc -f RMON EtherStats_importdata.pro

If you do not type this command, OVPI will import your file at 4:00 a.m., well before daily,
monthly, and forecasting summaries are started. If the default source and destination
directories have not been modified, the import command will import data from, and the export
command will export data to, the following directory:

SDPIPE_HOME/data/PropertyData
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The following table describes the format of the Property Import file. If you are creating this
file yourself, make sure that your file adheres to this format. The sequence of attributes left to
right must follow this sequence of attributes top to bottom and your attributes must be
delimited by tabs, not spaces.

Attribute Type Default Description

Node name char_string,64 N/A Device name.
Interface name char_string,188 | N/A Interface name.
BcastMcastThreshold | integer 50 Broadcast/ Multicast

Threshold. The percentage of
traffic of type Broadcast or
Multicast.

If you export this file from OVPI, the format will be correct; no checking is necessary.

Using the Change Threshold Form

The value for Broadcast/Multicast Threshold is defaulted to 50%. Follow these steps to open
the Change Threshold form and modify the Broadcast/Multicast Threshold:

1 Open the Management Console.
2 Click the Objects icon.

3 Navigate to the interface you want to update and select it; or navigate to the device, if you
want to update the threshold for all of the interfaces on that device, and select it.

4 The Change Bcast-Mcast Threshold form is listed along with other change forms under

Object Specific Tasks.

5 Double-click the Change Bcast-Mcast Threshold form. The form opens.
Update the threshold as required.

7 Click Apply to save changes, then click OK to save changes and close the form. If you do not
want to save the changes you made, click Cancel.
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0VPI'forms\deploy'admin\RMON_EthernetStatistics. ar I =1 |

RMON Ethernet Statistics /)
Change Threshold Fvﬁ;

s

Use this form to change the default settings for Interface for the RMON Ethernent Statistics report
pack. You can modify the default Broadcast Multicast threshold settings for each Interface. Select
the Device, Interface you want to change the seftings for, and then enter the new settings below.
Click the Apply button to save any changes. Clickthe Cancel button to cancel any changes. Click
the OK hutton to save changes and close the form.

Device and Interface List
Device Name Interface Name Default BcastMcast Threshold

Broadcast Multicast Threshold

6] Apply I Cancel I

Conditions for Sending Traps to NNM

The thresholds sub-package that comes with RMON Ethernet Statistics 3.0 will send a
threshold trap to your NNM server if the following two conditions are in effect at the same

time:
e The Broadcast/Multicast Threshold is being exceeded.
e The Utilization Threshold is being exceeded.

Changing Thresholds
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The utilization threshold is inherited from the Interface Reporting Report Pack. To modify
this threshold, use the Change Protocol Defaults form, shown below. For more information
about this and other forms bundled with Interface Reporting, refer to the Interface Reporting
Report Pack 5.2 User Guide.

[fi| /admin/Interface_Reporting_Forms/change_protocol_defaulks - IEllil

Interface Reporting (ﬁB

Change Protocol Defaults

inwvent

IIse this form to change the default settings for Protocols (interface types) for the Interface Reporing
report pack. You can change the names for Unknown protocols, and modify the default duplex and
threshold settings for each protoocol. The systerm can be configured to not poll interface types that
have the Monitar flag setto OfF (0). Select the Protocol you want to change the settings for, and then
enter the new settings below. Click the Apply buttan to save any changes. Click the Cancel buttan to
cancel any changes, Click the QK hutton to save changes and close the farm.

Default Default Det

ifType Protocol Hame Duplex Monitor Lhilization Discard Er
Threshold Threshold Thre
1 other 2 1 20,00 1.00 - i’
z regularigzz z 1 Q0.00 200 p
. hdh1822 z 1 Q0,00 200 p
4 ddn-x25 z 1 Q0,00 200 p
5 87 725 z 1 a0.00 Z00 y
G ethernet-czamacd 1 1 2000 1.00 E
7 iZ0S2023-camacd 1 1 a0.00 Z00 y
& iso-ZE02<-tokenBus 1 1 £0.00 Z00 y
g iz0-22025-tokenRing 1 1 £0.00 200 y
10 is02026-man z 1 an.00 Z0oo i
44 —tarl an ] 4 (mlnWulnl r N ninl -
4 e
Protocol Name ethernet-csmacd Monitor Manitar v
Litilization Threshold Error Threshold Discard Threshold
Thresholds 30.00 1.00 1.00
(0] 4 apply Zancel
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4 Setting Up a Distributed System

This chapter covers the following topics:
e Proper package installation

¢ Configuring a central server

e Configuring a satellite server

e System clocks

Proper Package Installation

If you intend to run the RMON Ethernet Statistics package as a distributed system, you must
configure all of the servers in the system. Before starting this task, use the following table to
verify that your servers are running the right packages.

Central Server Each Satellite Server

RMON_EthernetStatistics 3.1 RMON_EthernetStatistics 3.1

Common Property Tables 3.7 Common Property Tables 3.7

Interface Reporting 5.3 Interface Reporting 5.3

Interface Discovery Datapipe 2.5 Interface Discovery Datapipe 2.5

IR ifEntry Datapipe 2.5 IR ifEntry Datapipe 2.5
RMON EthernetStatistics Datapipe 3.0
RMON_EthernetStatistics_Thresholds
Thresholds Module 5.1

Typically, the central server does not poll. If you want the central server in your system to
poll, then you must install the RMON_EthernetStatistics Datapipe on the central server.

Configuring the Central Server

To configure the central server, perform the following tasks:
e Task 1: Register the satellite server by setting the database role
e Task 2: Enable LIR
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e Task 3: Add LIR mappings
e Task 4: Verify the automatically generated copy policies
e Task 5: Modify the trendtimer. sched file

Task 1:  Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.
Navigate to the OVPI Databases folder and select the database system.
Click Database Properties.

From the Database Role list, select the Satellite Server role.

o 0 A W N

Enter any information necessary to configure the Satellite Server role.

) To add a new database reference, you can use the Add Database Reference Wizard in the
System and Network Administration application.

Task 2:  Enable LIR

1 Start the Management Console (log on with Administrator privileges).
2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.
4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3:  Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.

Click LIR Configuration.

Click Add Mapping.

From the Select Satellite Server list, select a satellite server to which to add a mapping.
Select the Category data table option.

Select RMON Ethernet Statistics from the drop down list.

O 00 N 00 0 A W N

Select the rate data type.

—_
o

Click Add to List.

—_
—_

If you want to add additional LIR mappings, click Add to list and repeat step 6 through
step 10.

12 Click OK.
13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that
you add. The data type selected when adding an LIR mapping (in step 9 above) determines
the type of data copied that is defined in the generated copy policy (the type of data copied

Chapter 4



that is defined in the generated copy policy is for one greater than the data type selected in
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is
generated.

Task 4:  Verify the automatically generated copy policies

Verify that a copy policy has been generated for the SHRMONEtherStats table and that the
copy type is set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the SHRMONEtherStats table and verify the copy type is set to Property and Data.
If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

w

Select a satellite server from the pull down list. This is the satellite server from which
data is copied to the central server.

Select Single Table and select SHRMONEtherStats from the pull down list.
Click Next. The Copy Type Selection Page displays.

Select Property and Data.

Click Next. The Summary page displays.

0 N O O A

Verify the information in the summary window. If the information is not correct, you can
modify it by clicking Back.

9 Click Finish.

If the copy type is not set to Property and Data, do the following:
1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5:  Modify the trendtimer.sched file

The trendtimer. sched file is found in the {DPIPE HOME}/1ib/ directory where
{DPIPE HOME} is the directory in which OVPI is installed.

Make the following change to this file:
¢ Find and comment out the following line:

1:00+25 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/EtherStats Hourly Process.pro

Configuring a Satellite Server

Follow these steps to configure each satellite server.

1 Modify the {DPIPE HOME}/libtrendtimer.sched file (where {DPIPE HOME} is the
directory in which OVPI is installed). Find and comment out the following line:

Setting Up a Distribufed System 25
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24:0045:00 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/EtherStats DMF Process.pro

2 Modify the EtherStats Hourly Process.pro file.

The EtherStats Hourly Process.pro fileis found in the {DPTPE HOME}/scripts/
directory where {DPIPE HOME} is the directory in which OVPI is installed.

Make the following change:
¢ Find and uncomment the following lines:
# begin: EtherStats 2 wait

# {DPIPE HOME}/bin/perl {DPIPE HOME}/scripts/IR Performance.pl -p
"Sat 1 EtherStats Copy" -t hour -v start

# {DPIPE HOME}/bin/trendcopy -t SHRMONEtherStats

# {DPIPE HOME}/bin/perl {DPIPE HOME}/scripts/IR Performance.pl -p
"Sat 1 EtherStats Copy" -t hour -v stop

# end: EtherStats 2

3 Configure polling policies for the RMON Ethernet Statistics Datapipe, making sure that
each interface is polled by only one satellite server.

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock
on the central server. This step is extremely important. In distributed environments, linked
processes must execute in exact sequences across independent machines.
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5 The Demo Reports

The chapter contains:
e A brief overview of the contents of each report (eight reports total)
e Screen captures

The screen captures come from the demo package.

1. Historical Broadcast + Multicast Packet Analysis

e Packet volume per interface for yesterday

e Ratio of broadcast traffic to multicast traffic for yesterday

e  Multicast, broadcast, and unicast packets over two days (hourly)

e Multicast, broadcast, and unicast packets over previous 31 days (daily)
e  Multicast and broadcast packet distribution for the previous 31 days

e Interface utilization over the previous 31 days

2. Near Real Time Broadcast + Multicast Packet Analysis [note: not illustrated]

e Packet volume per interface for the previous 12 hours

e The ratio of broadcast traffic to multicast traffic for the previous 12 hours

e Counts for multicast, broadcast, and unicast packets over the previous 12 hours

e Interface utilization over the previous 12 hours

3. Historical Packet Size Distribution

e Total number of packets for yesterday

¢ Percentage of packets with errors for yesterday

e Qctets for yesterday

e LAN segment utilization for yesterday

e Packet size distribution for previous two days (hourly)

¢ Packet size distribution for previous 31 days (daily)

e Percentage of broadcast and multicast packets for the previous 31 days

e Interface utilization for the previous 31 days

4. Near Real Time Packet Size Distribution

Total number of packets for the previous 12 hours

e Percentage of packets with errors for the previous 12 hours

Octets for the previous 12 hours

v



Utilization for the previous 12 hours
Packet size distribution for previous 12 hours
Percentage of broadcast and multicast packets for the previous 12 hours

Interface utilization for the previous 12 hours

. Historical Error Report
Packet volume per interface for yesterday
Percentage of packets with errors for yesterday
Percentage of packages with:
— Fragment errors
— CRCAlign errors
— Undersize errors
— Opversize errors
— Jabber errors
Error count for the previous2 days (hourly)
Error count for the previous 31 days (daily)
Collisions for the previous 31 days

Probe drop events for the previous 31 days

. Near Real Time Error Report
Packet volume per interface for the previous 12 hours
Percentage of packets with errors for the previous 12 hours
Percentage of packages with:
— Fragment errors
— CRCAlign errors
— Undersize errors
— Oversize errors
— Jabber errors
Error count for the previous 12 hours
Collisions for the previous 12 hours

Probe drop events for the previous 12 hours

. Drop Events Report

Customer selection list

List of devices associated with the selected customer
Drop events per device for yesterday

Drop events per interface for yesterday
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. Inventory Report
Customer selection list
List of devices associated with the selected customer

List of interfaces associated with the selected device
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RMON Ethernet Statistics (ﬁﬂ
Historical Broadcast + Multicast Packet Analysis

invent

Thiz report has one entry for each interface, data in the selection table relates to all of yesterday combined. The tabbed areas graph
movements ower the previous hours and days. Excessive (= 10%) broadcast or multicast padkets can be detrimental to netwotk peformance.
% Ml calculates the utilization using the provisioned ifSpeed for half duplex interfaces.

Interface Data From Yesterday

Device Interface Description Pkt= %o LHil Brast%  Mcast %
Device_1298 ) FastEthernetd 5 M &0 20 i‘
Device_ 1265 20 Maodule 7, Port 12 207 2158 a EE 22
Levice_ 1265 7e Module 7, Port 10 207,214 a EE 22
Device_1265 75 Module 7, Port ¥ 207 213 a 7a 22
Device 1265 94 hadule &, Part 4 207 213 u] 7E 2z
Lewvice_ 1265 59 Module 7, Port 1 207,211 u} Ta 22
Levice 1265 Eh| Module 7, Port 3 207,211 a 7a 22
Device_1Z265 T4 Module 7, Port G 207,211 a 7a 22
Device_ 1265 []a} Module G, Port 20 207,210 a EE 22
Device_ 1265 53 Module &, Port 12 207,208 a EE 22
Levice_ 1265 53 Module G, Port 7 207,208 a EE 22
Device_1265 52 Module &, Port 5 207 207 a 7a 22
Device 1265 42 Madule 5, Part 13 207 206 u] 7E 2z
Lewvice_ 1265 42 Module &, Port 19 207 206 u}

7S 22 j

Make Model Customer AdminStatus Protocol Speed
Foundry Netwats Metlron Figabit Switching Router Customer Unassigned Up izo32023-czmacd Mot set.

Hourly l DEI”':."]

Packet Type Distribution for Previous 2 Days
For Device_1298: FastEthernetd

100,20 T

B850 1 O rulticast %
i Bercadeast %

2340 1 Cunicast %

Wied 00:00 Wead 02:00 wed 16:00  Tho 0000 Tho O7:00 Tho 14:00 Tho 21:00 Fri 04:00  Fri 11:00
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Broadcast + Multicast Packet Counts

540 1

2E0 T

180 1

Facket Cournts

For Previous 31 Days

Sat
Mone 30

Mo
Dec 2
Tirme

Wizd
Dec 4

[ mutticast
.Elrcna-:lcast

B4 LHilization

o4 Litilization for Previous 31 Days

3760 T

2820 1

1280 1

.40 1

u]
Sat

Mo 30

han
Dec 2
Time

ied
Dec 4

— Wil Threshold
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RMON Ethernet Statistics

Historical Packet Size Distribution [B

invent

Thiz report has one entry for each inteface, data in the selection table relates to all of yesterday combined. The tabbed area= graph
movements owverthe prewious hours and daws. % Errar Phis is the percentage of all packets which were counted as having errars. % Uil
caleulates the utilization using the provisioned ifSpeed for half duplex intefaces.

Interface Data From Yesterday

Device Interface De=scription Pkt= % Error Pkt Octets %o LHil
Device_ 1286 1 ZigabitEthernet1i1 285,661,249 0.a0oaa 1206 B 1 i‘
Device_ 1286 129 F astEthernetdiM 247 398,123 0.a0oaa 115.4 GB 12
Device_1282 7 SummitfiT=Port 7 145,181 610 0.a0oaa 99.2 =B 11
Dewice_1289 25 FEMON Fort 25 on Unit 4 158,230,014 0.a000a a5.1 =B 1
Device_1200 25 RMON Fort 25 an Unit 1 165,265,132 0.00000 951 GB 1
Device_ 1288 25 FMOMN Fort 25 on Unit 1 155,187,720 0.a0oa0 931 =B 1
Device_ 1287 25 FMON Fort 25 on Unit 1 155,178,749 0.a0oaa 93.1 =B 1
Device_ 1293 13 F astEthernet13 1,395,119, 759 0.a0oaa 846 =B g
Device_ 1282 11 EMON Fort 11 on Unit 1 213,507 GGG 0.a0oaa 816 =B =]

Device_ 1283 11 RMON Fort 11 on Unit 1 213,500,099 0.a0oaa 216 =B g
Device_1282 2 RMON Fort2 on Unit 4 515,516 670 0.a0oaa 54.4 B =]
Dewice_1283 2 FEMON Fort2 on Unit 4 515,517 548 0.a000a 54.4 =B =]
Device_1300 113 Rt ON: 10000 Fort 13 on Unit 1 503,051 263 0.00000 G62.5 GB G
Device_ 1282 18 FMOMN Fort 12 on Unit 1 93,284,251 0.a0oa0 55.3 =B =] j
Make Model Customer AdminStatus Protocol Speed
Foundry et Fouter Customer Unassigned Up gigabitEthernet 1.0 Ghis

Haurly l Daily ]

Packet Size Distribution for Previous 2 Days
For Device_1266: GigabitEthernet1M

28,590,516.00
O Pits 54

@ Futs 65-127
W Fits 125-255
[ Pits 256511
W Fits 5121023
O Pkt 10241512

19,060,244 .00

9,530,172.00

n]
Wed 00:00 ‘Wwied 09:00 Wied 21:00 Thu 08:00 Tho 14:00 Tha 22:00 Fri 08:00
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Broadcast + Multicast Packets

B4 of All Packets

u]
Sat

Mo 30

For Previous 31 Days

han
Dec 2
Time

Wizd
Dec d

. Broadcast %
I tulticast %

U Litilization for Previous 31 Days

30.00

22480 1

15.00 1

Ba WHilization
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RMON Ethernet Statistics (ﬁﬂ
Near Real Time Packet Size Distribution

invent

This report has one entry for each inteface, data is displayed for the most recent poll eyele and the graphs show the previous 12 hours,
% Error Phts is the percentage of all padkets which wuere counted as having errors. % Wil calculates the utilization using the provisioned
fSpeed for half duplex intefaces.

Interface Data From Most Recent Poll Cycle
Change Constraints to Modify the List

Device Interface Description Pkts % Error Pkt Octets Yo LHil
revice_1Z2E2 10 SummitfiT=FPort 10 393,519 0.000a0 195.2 MB 2 =
Jewvice 1282 10 FhdOM Port 10 on Unit 1 384,820 0.000a0 283.5 b 3
Jewvice_ 1283 10 FrdOM Port 10 on Unit 1 384,635 0.000a0 2834 MbB 3
ewvice 12494 10 10 267 5653 0.000a0 148.3 B 1
evice 1242 10 izigabitEthern et 9,025 0.000a0 8735 KB u}

Jevice_ 1288 10 EmOM Port 10 on Unit 1 4,287 0.000a0 5047 KB u}
ewice_ 1287 10 EhOM Port 10 on Unit 1 4,285 0.000a0 504.5 KB a |
Jevice 1258 10 RhON FPart 10 on Unit 4 4254 0.00000 5045 KB u]
rewice_ 12090 10 FmdCOM Port 10 on Unit 1 4,274 0.000a0 s04.0 kB u}
Jewvice_ 12093 10 FastEthermeti0 4,224 160955 5153 KB u}
Jevice_ 1286 10 Bz2 1,629 0.000a0 148.2 KB u}
Jewvice_ 1298 10 FastEthernetio s07 0.000a0 51.0 KB u}
Jevice_ 1276 10 Summitd2i-Port 10 212 0.000a0 18.4 KB u} j
Duration
Customer AdminStatus Protocol Speed Poll Cycle Start (sec)
Customer Unassigned Up ethernet-csmacd 100.0 Mbes Fri DecOf 13:15:00 EST 2002 245

Packet Size Distribution For Previous 12 Hours
For Device_1262: Summit?iTx-Port 10

G29,165.10

I I O Pits 55t

“I|"""“ “ |I [ Pits 5127
| ‘II B itz 422255

Facket Count

O Pit= 256-514
B Fit= 5121023
O Pkts 10241512

01:00 Ak 0Z:30 AWM 0415 Al 05:45 AW 0730 Al 02:00 Akl 1035 Ak 12:15 Pl
Time
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Broadcast + Multicast %4 Liilization
For Previous 12 Hours For Previous 12 Hours

0.0 7 B0 T
4]
j c 23.70
& g
m ]
- . M qaszn
T M Broadeast % = 1 — % Uil
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o i t 0 — "
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RMON Ethernet Statistics [ﬁﬂ
Historical Error Report

inwvent

Thiz report alloves you to select interfaces based on their pedformance yesterday. The graphs below the selection table showe data for the
previous hours and days for the selected inteface. % Error Phits is the percentage of all padeets which vuere counted as hawving erars. Of the
ermor packets, % Frag is the ratio which were fragmented - the zame appliesto % CRC Align, % Under, % Ower and % Jabbers. Drop events
signify when the RMOM agent was unable to maintain the counters and had to ignore sets of packets.

Interface Data From Yesterday

Device Interface Pkt= YwErrorPkt “%wFrag % CRCAlign % Under Yo Ower % Jabbers
Device_ 1263 g 1 10000000 u} 100 u] a u] i‘
Drevice_ 1293 10 20675326 12 05186 100 u] u] a u]

Device_ 1243 102 232,595,144 2.027HM 100 u] u] a u]
Cravice_ 1301 1003 105,883 T ATET a5 54 u] a u]
Device_1294 1003 105,885 7 ATEES A6 54 u} u] u}
Device_ 1294 100G 258,201 A1 o5 5 u] u} u]
Crewice_ 1301 1006 258,219 AT a5 5 u] a u]
Device_ 1265 21 286,785 593537 u} 100 u] a u]
Drevice_ 1247 1014 1,466,452 386616 100 u] u] a u]
Drevice_ 1246 1014 1,466,459 2386616 100 u] u] a u]
Device_ 1293 = 542 595 366283 100 u] u] a u]
Crawice_ 1293 =1 829,206 251337 94 =] u] a u]
Device_ 1263 200 325932 165280 a9 1 u} u] u}
Device 12093 12 g54.523 1.55572 T oz u] u} u] j
Make Model Customer AdminStatus Protocol Speed
Foundry MNetwars Router Customer Unassigned Up gigabitEthernet Mot set.
Hourly l Dy ]

Error Counts for Previous 2 Days
For Device_1263: GigabitEthernet1/8

1.00
% B undemsize
-
o 0.50 |:|Eh.rersize
':; Eaatbers
= DFragment

+ + t t t t t t Ocre Align Errars
Wad 00:00 wed 02:00 Wed 16:00 Thu 00:00 Thu 02:00 Thu 1&:00  Fri O0:00 Fri O7:00

Time
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Packet Collision Counts for Previous 31 Days

ool 7

Prohe Drop Events for Previous 31 Days

0.0l 1
£ 5
3 [=]
g [
c ] T I
b =
i w
= o
a =
=]
u] t t t + t t u] t t t t t +
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RMON Ethernet Statistics ()
Near Real Time Error Report (a

invent

This report has one entry for each inteface, data is displayed for the most recent poll cycle and the graphs show the previous 12 hours.
% Errar Phts is the percentage of all padkets which were counted as hawing erors. Of the error padkets, % Frag is the ratio which were
fragmented - the same appliesto % CRC Align, % Under, % Ower and % Jabbers.

Interface Data From Most Recent Poll Cycle
Change Constraints to Modify the List

Device Interface Pkt= % Error Pkt % Frag % CRCAlign % Under % Ouer % Jabbers
Drewice_ 1293 10 224 160955 100 u] u] u] u] =
Crevice_ 1251 10 u] 0.000o0 o u] u] u] u]

Drewice_ 1252 10 u] 0.000o0 o u] u] u] u]
Drewice_1249 10 u] 0.00a00 u] u] u] u] u]
Drevice_ 1244 10 267 G653 000000 u] u} u] u] u}
Device_1287 10 4,286 0.00000 o u] u] u] u]
Crewice_1283 10 4287 0.000o0 o u] u] u] u] —
Crewice_12589 10 42584 0.000o0 o u] u] u] u]
Crevice_ 1280 10 4,279 0.000o0 o u] u] u] u]
Crewice_ 1286 10 1,629 0.000o0 o u] u] u] u]
Drewice_1284 10 3 0.000o0 o u] u] u] u]
Drewice_1282 10 284,820 0.00a00 u] u] u] u] u]
Device_ 1283 10 384,635 000000 u] u} u] u] u} j
Duration
Customer AdminStatus Protocol Speed Poll Cycle Start (sec)
Customer Unassigned Up izoBE023- cemacd 10.0 b=z Fri Dec 05 13:15:00 EST 2002 205
Error Packets

Total Packet Counts for Previous 12 Hours

23220 1 _

5
8 18480 T B Undersize
E 1 DDxrersize
Eﬂ | H_‘ ’_H ﬂ Huatbers

| F t=

0 :H ITlI'II?LH S = O 'S |-||_||_| ool 0 ragmen
Fri Fri Fri Fri Fri Fri Fri Fri Fri CJcro Align Emors
0100 Akt 02:30 Al 04:00 Ak 05:230 Ahd 0700 AM 02230 Ak 10:00 AR 4130 AW 04:00 P
Time
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Packet Collision Counts Prohe Drop Events

For Previous 12 Hours For Previous 12 Hours
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RMON Ethernet Statistics [}
Drop Events Report (B

invent

This report has ane entry for each customer and provides information on aggregated Drop Events for each RMON Ethernet Statistics enabled
device, A'DropEwent is defined as"The total number of events in which packets were dropped by the probe due to ladk of resources. Maote
that thiz number iz not neces=zarily the number of packets dropped; it is just the number of times this condition has been detected.”

Modify the report constraints to limit the number of intefaces displayed. Only devices palled westerday will be displayed.

Customer Customer Id

Customer Unassigned -2

Devices Associated the Selected Customer

With DropEvents Yesterday
Device Make Model Drop Events
Lrewvice 1284 Intel Carporation A50T Standalone Switch (24 pard). 45

Interfaces Associated with 64.42.232.1: Intel Express 460T Standalone Switch (24 port).
Change Constraints to Modify the List

Interface etherStatsindex AdminStatus Protocol Full/Half Speed Drop Events
1 1 Up ethernetcsmacd H 100.0 hMb/is 45
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RMON Ethernet Statistics
Inventory Report

(/3

invent

Thiz report has one entry for each customer and provides inwentary information for the provisioned interfaces supporting RMOM Ethernet

Statistics data. Modify the report constraints to limit the number of intedfaces displayed. Onby intefaces which were polled yesterday will be

displayed.

Device
Dewvice_ 14160
Cewvice_ 1161
Dewice_ 1162
Dewvice_ 11632
Dewice_ 12442
Levice_ 1243
Device_ 1244
Device_ 1245
Dewvice_ 1246
Device_ 1247
Dewice_1243
Lrewice_ 1249
Lrewice_ 1250
Crewice_ 1251
Device_ 1252
Device_ 1255

Interface
B 1

The Demo Reports

Customer

Customer Unassigned

Customer Id

Devices Associated with the Chesen Customer

Make

nrellfleet

Hylan Carp.
Extrame Metwods
Extreme MNetwades
Foundry et
3Com

Hewlett Packard
Intel Carporation
Extrame Mebuods
Extrame Metwods
'ellfleet
Extreme MNetwades
Extrame Mebuors
Extreme Metuors
Extrame Metuors

Cisco

Model
M
Alcatel OmniSwitch
SummitdZi
Summits

Sernverlron Switch
SuperStack 1l

JAE13A ProCunre Switch 2524
550T Express 550T Switch
Alpine3208

Alpine3208

MR

Summitds

Summitds

Summitds

Summitds

TZ205W R

syzlescr

Image: relf13.10¢ Created an M.

Alcatel OmniSwitch
SummitdSi - Wersion §.2.2 (Bui...

Summitd2 - Wersion 4.1.19 (Bui...

Foundry Metwardes, Inc Senverl...
3Com SuperStad |l

HF J4213A ProCumre Switch 2524,

(e Intel Corporation, 50T Ex...
Alpine3308 - Wersion §.2.2 (Bu...
Alpine3308 - Wersion §.2.2 (Bu...

Image: rewM4.00/M 05 Created ...
Summitd2 - Wersion 4.1.19 (Bui...
Summitd2 - Wersion 4.1.19 (Bui...
Summitds - Wersion 4.1.19 (Bui...
Summitds - Wersion 4.1.19 (Bui...

Cisco Internebwok Operating 5...

Interfaces Associated with the Chosen Device
65.113.244.1: Image: reli13.10/ Created on Mon Nov 23 19:10:42 EST 1998.

etherStatsindex

AdminStatus

Up

Protocol  FullHalf
other F

Speed

Location
In: 100.0 Mbdz Out: 100.0 Mbfs Location Unassigned

I

|4
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A Version History

Version |Release Date Enhancements

1.0 May 2003 8 reports
Sybase support
RMON_EthernetStatistics Datapipe 1.0

2.0 October 2003 OVPI Object Manager support
RMON_EthernetStatistics Datapipe 2.0

3.0 April 2004 OVPI 5.0 support
Oracle support
RMON_EthernetStatistics Datapipe 2.0

3.0 August 2004 Upgrade package (to_3.0)

3.1 April 2007 new features:

e Location Independent Reporting (LIR)

e Supports Management Console > Copy Policy Manager
e Rate data removed from top-level table in NRT reports
e SQL modified for object delete

new upgrade package:

¢ UPGRADE_RMON_EthernetStatistics_to_31.ap
new release of the datapipe:

¢ RMON_EthernetStatistics Datapipe 3.1

defect fix:

e QXCR1000089875

3.1 October 2007 new release of the datapipe:

¢ RMON_EthernetStatistics Datapipe 3.2

defect fixes:

e QXCR1000412540: RMON EtherStats mapper fails to
manage interface_fk correctly

e QXCR1000423216: Compilation error due to ambiguous
columns, while inserting into K. RMONEtherStat
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B Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate,
you can easily change to a different view. If you are using Report Viewer, right-click the object
to open a list of view options. If you are using the Web Access Server, follow these steps to
change the default view of a table or graph:

1 Click Preferences on the links bar.
Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

o O AW N

Click the Edit icon next to the table or graph.

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options.

Sek Time Periad.. .
Zhange Conskraink Yalues. ..

Seleck Modes/Interfaces. ..

Change Max Rows. ..
Wiew in new Frame

Print Table...

Export Element as C54. ..
Celete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.
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Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node

Selection Type window opens.

Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

ges Table ¥Yiewer

Polled IP Q¢S Statistics Data - Input
Over Previous 6 Hours

IpPrecedence
u]

o T N = N I e I OO % N e R e T I B O o < N = N = ) B O 1 T % N e N R e R O O

Switched Bytes
105,688

Switched Plis

G675

O th O O O O O

63

1]

G

DADDDDCl%DDDDDDD

il

L T e O O o e Y o I o

G5

o o o o

Tirme Period
Tue Oct20 0700 Ahd
Tue Oct 29 0700 A
Tue Oct 29 0700 Ah
Tue Oct20 0700 Ahd
Tue Oct 29 0700 A
Tue Ot 29 0700 A
Tue Ot 29 0700 Ahd
Tue Oct 29 0700 A
Tue Ot 29 05495 A
Tue Ot 29 06495 A
Tue Oct29 0645 Ahd
Tue Oct 29 0645 Al
Tue Ot 29 05495 A
Tue Ot 29 0645 Ahd
Tue Oct 29 0645 Al
Tue Ot 29 05495 A
Tue Oct 29 06:230 A
Tue Oct 29 063230 Al
Tue Ot 29 06:30 Al
Tue Oct 29 06:230 A
Tue Oct 29 063230 Al
Tue Ot 29 0630 Al
Tue Oct 29 06:230 A
Tue Oct 20 06:30 Ak
Tue Oct 29 0615 Al
Tue Oct 29 0615 Al
Tue Oct 20 06:15 A
Tue Oct 29 0615 Al
Tue Oct 29 O6:15 Al
Tue Oct 29 06:15 A
Tue Oct 29 0615 Al
Tue Oct 29 O6:15 Al
Tue Oct 29 0500 Ahd
Tue Oct 20 0600 Ahd
Tue Ot 29 0600 A
Tue Oct 29 0500 Ahd
Tue Oct 20 0600 Ahd
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View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

409.00 1

327207

Odd Zrverlay,

Remove Syverlay

Set Time Period. ..
hange Constraint Yalues. .,

Zelect Modes)Interfaces. ..

Displayed Data 3
Legend ]
163 60 1 Skvle J
—hange Max Rows, ..
8180 1
Display Daka Table
o L : : : Export Elerment as CSY. .,
Sep 17 Sep Sep25  SepZd Display Gwverlay Daka Table
Export Graph Cverlaw Data as @5k, .,
Yiew in new Frame
Print araph. ..
Deleke Graph
The following table provides details about each option.
Option Function
Set Time Period Same as the table option shown above.
Change Constraint Values Same as the table option shown above.
Select Nodes/Interfaces Same as the table option shown above.
Displayed Data For every point on a graph, display data in a
spreadsheet.
Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
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Option

Function

Export Element as CSV...

Same as the table option shown above.

View in New Frame

Opens graph in a Graph Viewer window.

Print Graph

Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

Change Constraint Yalues,

Select Modes|Interfaces. ..

Displawed Data

3 L\} L

Grid ]
Legend 3 /\
| Skyle Hrea
“hange Max Rows, ., Skacking Area
Dizplaw Daka Table Bar
Export Element as C3S4. .. Stacking Bar
Displaw owetlay Data Table Pie
Expork Graph Owerlay aka as C5h . » Plot

Yiew in new Frame

Scakker Plak

Print Graph. ..

Hi-Lo

Lelete Graph

Hi-Lo-Open-Close

K

Style > Area

A aua

o P

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

[REEREIERE

9560 1+

olurme

T1.70 ¢

Sat Feb 24 08:00 AW EST
Mormal Disconnect (107 js 74.00

s

0 ; = ; ; ; ; ;
0400 0g:00 0200 10:00 12:00 1400 16:00 1200
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To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected

time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.

% 200.00

1E0.00

120.00

S0.00
40.00
0
bAon 04 Tue= O2 wWiad O3
M 2org Utilization cH)
B 14 23 Utilization ¢H3
I Uil Threshald
Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

14,924 00 ¢
as533.20 4
7,154 40 1

4 FTEIEO 4

Forecast Mindtes

238480 1

Thua 04 Fri 02 Sat 03 Sun 04 bon 05 Tue O wied OF
Days Of The Week
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Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows
in units of ten.

200.00
160,00

120.00

g0.00
40.00
]
Mon 041 Tue 02 Wad 03
M 2org Utilization ¢H)
I 1 3 Utilization ¢H)
M Uil Threshald
Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.

TE.00 7

B2.20 1

S ALPVIRS
Fy

31.40 1

1570 1

Mon 01 Tue 02 Wiyad 032

— Auwg tilization (H)
— M ax MHilization (H)
— Wil Threshald
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

B Under 1 minute

E petween 1 and § minutes

[ petween & and 20 minutes

[ Between 20 mingtez and 2 hours
M Between 2 hours and 12 hours
M 0ver 12 hours

If you are looking at data for more than one day, you will see multiple pie graphs, one for each
day.

Display Data Table

This option changes a graph into a spreadsheet.

=T
A Axis I Average I
Tue Feb 19 .., 0,509
Tue Feb 19 .., 0.621
Tue Feb 19 ... 1.026
Tue Feb 19 ... 0,362
Tue Feb 19 ... 1.171
Tue Feb 19 ... 1.051
Tue Feb 19 ... 0.234
Tue Feb 19 .., 0.526
Tue Feb 19 .., 1,433 L\\S
Tue Feb 19 .., 0,967
Tue Feb 19 .., 1.471
Tue Feb 19 ... 1,308
Tue Feb 19 ... 1.123
Tue Feb 19 ... 0,93
Tue Feb 19 ... 1.497
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View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

=|0l x|

Hetwork Response Time
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Glossary

broadcast packet

A packet that is transmitted to all hosts on an Ethernet. The reports in the RMON Ethernet
Statistics package show the ratio of broadcast packets to other types of packets.

collision

A collision is the result of two devices on the same Ethernet network attempting to transmit
data at exactly the same time.

drop event

An overrun at a port. The RMON port could not receive and process the traffic at full line rate
and had to drop some packets from the counters. Changes in drop events can be caused by an
overburdened RMON infrastructure.

fragment

A piece of a packet. Sometimes a communications packet being sent over a network has to be
temporarily broken into fragments; the packet is reassembled at the destination.

jabbers

Packets that were longer than 1518 octets and also contained alignment errors.

multicast packet

Communication between a single sender and multiple receivers on a network. The reports in
the RMON Ethernet Statistics package show the ratio of multicast packets to other types of
packets.

packet

A unit of data formatted for transmission on a network. Data is broken up into packets for
sending over a packet switching network. Packet counts are shown with discard ratios.

port

Any frame relay interface on any network device that supports MIB-II.

octet

Eight bits. The term “octet” is sometimes used instead of the term “byte” to avoid confusion,
because not all computer systems use bytes that are eight bits long. The reports in the RMON
Ethernet Statistics package show octet counts on the LAN segment.

oversize packets

The number of packets received that were longer than 1518 octets but otherwise well formed.
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Index

B
broadcast/multicast threshold, 20
Broadcast Packet, 53

C

change max rows option, 47

Change Protocol Defaults form, 22

Change Threshold form, 19
collection_manager, 14

Common Property Tables upgrade package, 14
customer-specific reports, 9

custom views of data or property tables, 15

D

Datapipe Manager, 15
demo package, 10
Display Data Table, 47
displayed data option, 47
Drop Events, 53

Drop Events Report, 28

E

editing parameters, 10

exporting property data from OVPI, 19

G
grid options, 47
group_manager, 14

group filters, 9

H

Historical Broadcast + Multicast Packet Analysis, 27

Historical Error Report, 28
Historical Packet Size Distribution, 27

|
importing property data, 19
Inventory Report, 29

L
legend options, 47

M
Multicast Packet, 53

N

Near Real Time Broadcast + Multicast Packet
Analysis, 27

Near Real Time Error Report, 28
Near Real Time Packet Size Distribution, 27

P

polling policies, 14, 26
property import file, 19

R
RMON_EtherStats_exportdata.pro, 19
RMON_EtherStats_importdata.pro, 19

S

style options for graphs, 47
system clocks, 26

U
Use Absolute Time, 45

\'

view in new frame, 46
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